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SOFTWARE LICENSE AGREEMENT
INSTALLING OR OTHERWISE USING THIS SOFTWARE PRODUCT CONSTITUTES YOUR
ACCEPTANCE OF THE FOLLOWING TERMS AND CONDITIONS (UNLESS A SEPARATE LICENSE
IS PROVIDED BY THE SUPPLIER OF APPLICABLE SOFTWARE IN WHICH CASE SUCH SEPA-
RATE LICENSE SHALL APPLY). IF YOU DO NOT ACCEPT THESE TERMS, YOU MAY NOT
INSTALL OR USE THIS SOFTWARE, AND YOU MUST PROMPTLY RETURN THE SOFTWARE TO
THE LOCATION WHERE YOU OBTAINED IT.

THE SOFTWARE INSTALLED ON THIS PRODUCT INCLUDES NUMEROUS INDIVIDUAL SOFT-
WARE COMPONENTS, EACH HAVING ITS OWN APPLICABLE END USER LICENSE AGREE-
MENT (“EULA”). INFORMATION RELATING TO THE EULAS MAY BE FOUND IN AN
ELECTRONIC FILE INCLUDED ON THE USER DOCUMENTATION CD-ROM INCLUDED HERE-
WITH; HOWEVER, ALL SOFTWARE AND DOCUMENTATION DEVELOPED OR CREATED BY OR
FOR TOSHIBA TEC CORPORATION (“TTEC”) ARE PROPRIETARY PRODUCTS OF TTEC AND
ARE PROTECTED BY COPYRIGHT LAWS, INTERNATIONAL TREATY PROVISIONS, AND
OTHER APPLICABLE LAWS.

Grant of License
This is a legal agreement between you, the end-user (“You”), and TTEC and its suppliers. This software,
fonts (including their typefaces) and related documentation (“Software”) is licensed for use with the system
CPU on which it was installed (“System”) in accordance with the terms contained in this Agreement. This
Software is proprietary to TTEC and/or its suppliers.

TTEC and its suppliers disclaim responsibility for the installation and/or use of this Software, and for the
results obtained by using this Software. You may use one copy of the Software as installed on a single Sys-
tem, and may not copy the Software for any reason except as necessary to use the Software on a single Sys-
tem. Any copies of the Software shall be subject to the conditions of this Agreement.

You may not, nor cause or permit any third party to, modify, adapt, merge, translate, reverse compile, reverse
assemble, or reverse engineer the Software. You may not use the Software, except in accordance with this
license. No title to the intellectual property in the Software is transferred to you and full ownership is
retained by TTEC or its suppliers. Source code of the Software is not licensed to you. You will be held
legally responsible for any copyright infringement, unauthorized transfer, reproduction or use of the Soft-
ware or its documentation.

Term
This license is effective until terminated by TTEC or upon your failure to comply with any term of this
Agreement. Upon termination, you agree to destroy all copies of the Software and its documentation.

You may terminate this license at any time by destroying the Software and its documentation and all copies.

Disclaimer of Warranty
THIS SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-INFRINGE-
MENT. TTEC AND ITS SUPPLIERS DISCLAIM ANY WARRANTY RELATING TO THE QUALITY
AND PERFORMANCE OF THE SOFTWARE. IF THE SOFTWARE PROVES DEFECTIVE, YOU (AND
NOT TTEC OR ITS SUPPLIERS) SHALL BE RESPONSIBLE FOR THE ENTIRE COST OF ALL NEC-
ESSARY SERVICING, REPAIR OR CORRECTION. TTEC AND ITS SUPPLIERS DO NOT WARRANT
THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS
OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE.

ALL INFORMATION CONTAINED HEREIN THAT IS PROVIDED BY TTEC AND ITS AFFILIATES
PURSUANT TO A EULA IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED.

Limitation of Liability
IN NO EVENT WILL TTEC OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY DAMAGES,
WHETHER IN CONTRACT, TORT, OR OTHERWISE (EXCEPT PERSONAL INJURY OR DEATH
RESULTING FROM NEGLIGENCE ON THE PART OF TTEC OR ITS SUPPLIERS), INCLUDING
WITHOUT LIMITATION ANY LOST PROFITS, LOST DATA, LOST SAVINGS OR OTHER INCIDEN-
TAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO
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USE THE SOFTWARE, EVEN IF TTEC OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSI-
BILITY OF SUCH DAMAGES, NOR FOR THIRD PARTY CLAIMS.

U.S. Government Restricted Rights
The Software is provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S. Govern-
ment is subject to restrictions set forth in subdivision (b) (3) (ii) or (c) (i) (ii) of the Rights in Technical Data
and Computer Software Clause set forth in 252.227-7013, or 52.227-19 (c) (2) of the DOD FAR, as appro-
priate. Contractor/Manufacturer is TOSHIBA TEC Corporation, 2-4-1, Shibakoen, Minato-ku, Tokyo,
105-8524, Japan.

General
You may not sublicense, lease, rent, assign or transfer this license or the Software. Any attempt to subli-
cense, lease, rent, assign or transfer any of the rights, duties or obligations hereunder is void. You agree that
you do not intend to, and will not ship, transmit (directly or indirectly) the Software, including any copies of
the Software, or any technical data contained in the Software or its media, or any direct product thereof, to
any country or destination prohibited by the United States Government. This license shall be governed by
the laws of Japan or, at the election of a Supplier of TTEC concerned with a dispute arising from or relating
to this Agreement, the laws of the Country designated from time to time by the relevant Supplier of TTEC. If
any provision or portion of this Agreement shall be found to be illegal, invalid or unenforceable, the remain-
ing provisions or portions shall remain in full force and effect.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREEMENT AND THAT YOU
UNDERSTAND ITS PROVISIONS. YOU AGREE TO BE BOUND BY ITS TERMS AND CONDI-
TIONS. YOU FURTHER AGREE THAT THIS LICENSE AGREEMENT CONTAINS THE COMPLETE
AND EXCLUSIVE AGREEMENT BETWEEN YOU AND TTEC AND ITS SUPPLIERS AND SUPER-
SEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, OR ANY OTHER COM-
MUNICATION RELATING TO THE SUBJECT MATTER OF THIS LICENSE AGREEMENT.

TOSHIBA TEC Corporation, 2-4-1, Shibakoen, Minato-ku, Tokyo, 105-8524, Japan.
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TRADEMARKS AND COPYRIGHT

Trademarks
• The official name of Windows 98 is Microsoft Windows 98 Operating System.
• The official name of Windows Me is Microsoft Windows Me Operating System.
• The official name of Windows 2000 is Microsoft Windows 2000 Operating System.
• The official name of Windows XP is Microsoft Windows XP Operating System.
• The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.
• Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft prod-

ucts are trademarks of Microsoft Corporation in the US and other countries.
• Apple, AppleTalk, Macintosh, Mac, TrueType, and LaserWriter are trademarks of Apple Computer Inc.

in the US and other countries.
• Postscript is a trademark of Adobe Systems Incorporated.
• Netscape is a trademark of Netscape Communications Corporation.
• IBM, AT and AIX are trademarks of International Business Machines Corporation.
• NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
• Other company names and product names in this manual are the trademarks of their respective compa-

nies.

Copyright
© 2003 TOSHIBA TEC CORPORATION All rights reserved

Under the copyright laws, this manual cannot be reproduced in any form without prior written permission of
TTEC. No patent liability is assumed, however, with respect to the use of the information contained herein.
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Preface

Thank you for purchasing e-STUDIO4511 Series, e-STUDIO450 Series, or e-STUDIO280
Series Multifunctional Digital Systems. This Network Fax Guide explains instructions on how
to use the N/W-Fax driver and Address Book Viewer.  Read this guide before operating the net-
work fax features for the e-STUDIO4511 Series, e-STUDIO450 Series, or e-STUDIO280 Series
from client computers.  Keep this guide within easy reach, and use it to configure an environ-
ment that makes best of the e-STUDIO’s functions.

About This Guide
The Network Fax Guide provides detailed instructions for installing, setting up and using
optional Network Fax Feature for the e-STUDIO4511 Series, e-STUDIO450 Series, or
e-STUDIO280 Series. With this option installed, you can perform the following functions:
• Fax electronic documents from your workstation.
• Use the N/W-Fax driver installed on your workstation to manage faxes: select recipients and

send electronic documents from your desktop.
• Use the Address Book Viewer installed on your workstation to manage recipient informa-

tion.

Conventions
• The term “this equipment” in this manual refers to the e-STUDIO4511 Series,

e-STUDIO450 Series, or e-STUDIO280 Series.
• The term “e-Filing” in this manual is an abbreviation of “electronic filing”.

About Other Manuals
Other guides are included in the User Documentation CD-ROM provided with this system:
Printing Guide—explains how to install user software for the printer functions, including how
to set up and manage print jobs from Microsoft Windows, Apple Mac OS, and UNIX computers.
Network Operator’s Guide—explains how to set up and manage network functions using the
TopAccess user functions — such as network job management and template registration — from
client computers via a network.
Network Administrator’s Guide—explains the basic configuration and administration of the
equipment in supported platform and network environments. It also includes guidelines for set-
ting up network servers to provide various network services.
e-Filing Guide—explains how to operate the e-Filing features by using the TWAIN driver, File
Downloader and e-Filing web utility.
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1. OVERVIEW
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Features and Functions

This equipment provides the network fax feature, which simplifies and facilitates your office
facsimile needs that enables you to send fax or Internet fax digital documents directly from your
desktop.
This equipment also includes an Address Book database, where you can store frequently used
fax numbers or Internet Fax destinations and other important recipient information, such as com-
pany name, telephone number and postal address.

NOTE: • The fax transmission using the N/W-Fax driver is available only when optional Fax
unit is installed.

Functional Highlights
The highly intuitive, network N/W-Fax driver software enables you to select the fax printer
driver to electronically faxes from your computer to one or more recipients. You can easily
define fax job properties from the send list to fax resolutions. The N/W-Fax driver is compli-
mented with the Address Book Viewer. The combination of applications enables you to easily
manage a selection of fax recipients and access the Address Book.

Software Components

N/W-Fax Driver
The N/W-Fax driver enables you to set up send lists and send electronic documents from your
PC to one or more destinations. You print to the fax much the same way you would choose to
print to a designated printer that makes using the N/W-Fax driver quick and simple. You can
select the fax properties. Fax properties are the attributes you can set to define sender and recip-
ient information for processing fax jobs such as dialing options, sender information, fax resolu-
tion and page layout.
Other features include an easy to use fax scheduler that allows you to set up a date and time to
transmit your fax. Cover page options are also provided. You can include a customized cover
page with your fax transmission that can include sender and recipient fax information and a
detailed message. You can easily maintain sender and contact information that can be printed on
the cover pages.

NOTE: • Faxing hard-copy documents must be performed as a walk-up function from the
Touch Panel Display.

Address Book Viewer
With the Address Book Viewer you can effortlessly add or modify fax recipient names, fax num-
bers, and Internet Fax address (e-mail address) to the Address Book. This utility allows you to
manage recipients of the fax, select and display fax recipients from the Address Book, as well as
recipient fax numbers and other contact information.
Additionally, Address Book Viewer allows you import or export address book data to or from
other address book programs compatible to this equipment.

For e-STUDIO450 Series and e-STUDIO280 Series:
• The fax transmission using the N/W-Fax driver is available only when the Printer Kit or

Printer/Scanner Kit is installed in addition to optional Fax unit.
• The Internet Fax transmission using the N/W-Fax driver is available only when the Printer

Kit and Scanner Upgrade Kit are installed, or when the Printer/Scanner Kit is installed.
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2. INSTALLING CLIENT SOFTWARE
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Installing Network Fax Software

This chapter includes procedures for installing software required to enable the fax printing and
online address books for this equipment. It is recommended that you read these instructions in
their entirety before beginning the installation process.

Overview
Before you can begin utilizing the network fax feature for this equipment, you must install the
software using the Client2 CD-ROM provided. You will use the InstallShield client software
setup process.This section describes several ways to add N/W-Fax driver to user’s workstations.
Prior to installing the N/W-Fax driver and Address Book Viewer, the administrator must install
specific hardware and configure the fax options. Only authorized users can modify the device.

System Requirements
The TWAIN driver and File Downloader are available for following environments:

Display Resolution
• 1024 x 768 dots or more

Display Color
• High Color (16bit) or higher is recommended

CPU
• Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)

Memory
• 64MB for Windows 98
• 96MB for Windows Me and Windows NT 4.0
• 128MB for Windows 2000/XP/Server 2003

OS
• Windows 98 (Windows 98 Second Edition Recommended)
• Windows Me
• Windows NT 4.0 Service Pack 6a
• Windows 2000 Service Pack 3
• Windows XP Service Pack 1
• Windows Server 2003

Before Installing Client Software
Before installing the client software, confirm the followings to perform an appropriate installa-
tion.

— When Address Book Viewer Has Been Installed
If the Address Book Viewer has been installed from either the e-STUDIO4511 Series Client2
CD-ROM, e-STUDIO450 Series Client2 CD-ROM, or e-STUDIO280 Series Client2 CD-ROM,
you do not have to install it from the other one.  In that case, please install only the N/W-Fax
driver.
If you want to install Address Book Viewer from the other CD-ROM, uninstall the Address
Book Viewer then install it.  When you uninstall the Address Book Viewer, please click [No] at
the dialog box that displays the message to delete the settings for the Address Book Viewer so
that you can restore the settings after installing new one.

Installing the N/W-Fax Driver and Address Book Viewer
You can install the N/W-Fax driver and Address Book Viewer from the Client2 CD-ROM or
TopAccess.
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This section describes about installing the N/W-Fax driver and Address Book Viewer in the
SMB environment.  The  N/W-Fax driver can be set up in the same connection as the printer
driver such as Parallel printing, USB printing, LPR printing, Peer-to-Peer printing, IPP printing,
and Novell printing.  To set up the N/W-Fax driver in these connections, please refer to the
Printing Guide.

Installing from Client2 CD-ROM
This section describes how to install the fax client software for SMB environment which is
available for the local area network over TCP/IP.

NOTE: • When the Network Interface Card is not installed, set up the N/W-Fax driver using
Parallel printing or USB printing.  Also Address Book Viewer is not available unless
the Network Interface Card is installed.  To set up the N/W-Fax driver in these con-
nections, please refer to the Printing Guide.

PREPARATIONS: • Before installing the printer driver for SMB environment, check with your system
administrator to make sure of the following:
- This equipment is connected to the network and turned on.
- The TCP/IP setting is correct on this equipment and your computer.

Installing the fax client software for SMB connection using the 
installer

The procedure here describes an installation on Windows 2000.  The procedure is the same when
other versions of Windows are used.

REQUIREMENT: • You must log in Windows as a user who has the “Administrators” or “Power Users”
privilege when using the Windows NT 4.0, Windows 2000, Windows XP, or Win-
dows Server 2003.

1. Insert the Client2 CD-ROM into the CD-ROM drive.
• The installer automatically starts and the Choose Setup Language 

dialog box appears.
• When the installer does not automatically start, double-click 

“Setup.exe” in the Client2 CD-ROM.

2. Select your language and click [OK].

• The InstallSheild Wizard dialog box appears.
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3. Click [Next].

• The License Agreement screen is displayed.

4. Click [Yes].

• The Choose Destination Location screen is displayed.

5. Click [Next].

• If you want to change the location where the programs are installed, 
click [Browse].  In the dialog box appears, select the folder and click 
[OK].

• The Setup Type screen is displayed.
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6. Check the software that you want to install.

TOSHIBA e-STUDIO N/W-Fax — check this to install the N/W-Fax driver.
TOSHIBA e-STUDIO AddressBookViewer — check this to install the Address 
Book Viewer.

SUPPLEMENTS: • In the components list, there are also “TOSHIBA e-STUDIO TWAIN Driver” and
“TOSHIBA e-STUDIO File Downloader”.  You can install them together in the same
operation.  For more information about the TWAIN driver and File Downloader,
please see the e-Filing Guide.

• If no changes are made, all four options will be installed.

7.  Click [Next].
• The Select Port dialog box appears.

8. Click [Browse].

• The Browse for Printer dialog box appears.

SUPPLEMENT: • You can also automatically specify the network queue by searching the equipment
in the network.

 P.17 "Using the Discovery Functions to Specify the SMB Port"
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9. Locate this equipment in your network, select the “print” 
queue, and click [OK].

• Returns you to the Select Port dialog box.

10. Click [Next].

• The Select Program Folder screen is displayed.

11. Click [Next].

• If you want to change the program folder, rename the folder name in 
the “Program Folders” field.

• The Starting Copying Files screen is displayed.
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12. Click [Next].

• Starts copying files and the InstallShield Wizard Complete screen is 
displayed when copying files are completed.

13. Select “Yes, I want to view the Read Me file.” and click [Fin-
ish].

• The installation is completed.

NOTE: • The Installer may ask you to restart your computer.  If it does, select “Yes, I want to
restart my computer now.” and click [Finish] to restart your computer.

— Using the Discovery Functions to Specify the SMB Port
In the Select Port screen during the installation, you can also obtain the network queue name
automatically by searching the equipment.
There two ways to obtain the SMB printer port from the equipment:

 P.18 "Searching the equipment automatically"

 P.20 "Specifying the IP address manually"
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Searching the equipment automatically

1. Click [Discovery].

• The TopAccessDocMon Local Discovery dialog box appears.
1. Click [Start Discovery].

• It starts searching the equipment in the network.
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SUPPLEMENT: • It searches the equipment within the local subnet in your network.  If the equipment
is located in the different subnet from your computer, or you want to specify the IP
address range to be searched, click [Advance].  The Discovery Settings dialog box
appears and you can specify the advanced settings for searching the equipment.

• Devices — You can specify the device models to be searched.  This sets to search the
e-STUDIO4511 Series, e-STUDIO450 Series, or e-STUDIO280 Series, so you do
not have to change this options.

• Network - Enable IPX/SPX Search — Check on this to search printers which con-
nect to the IPX/SPX network.  This is available only when the IPX/SPX protocol
and Novell Client are installed in your computer, and the computer is connected to
the NetWare server.

• Network - Enable TCP/IP Search — Check on this to search printers which con-
nect to the TCP/IP network.  This is available only when the TCP/IP protocol is
installed in your computer.  When this is enabled, select how it searches printers in
the TCP/IP network.
Search local subnet — Select this to search printers in local subnet.
Specify a range — Select this to search printers in specific range of IP addresses.
When this is selected, enter the IP addresses in “From” field and “To” field to spec-
ify the range.

2. Select the equipment that you want to connect and click [OK].
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3. It automatically obtains the network queue in the “Network 
path or queue name” field.

NOTE: • It automatically obtains the IP address of the equipment and the queue name speci-
fied by an administrator, in the “Network path or queue name” field in the General
submenu page of the Setup menu in the TopAccess administrator mode.  If you can-
not obtain the queue name, ask your administrator that the “Network path or queue
name” field is correctly specified.

4. Continue the installation from step 10 on page 16.

Specifying the IP address manually

1. Click [Discovery].

• The TopAccessDocMon Local Discovery dialog box appears.
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2. Click [Manual Selection].

• The Manual Selection dialog box appears.

3. Enter each item to specify the printer address and click [OK].

IP Address — Enter the IP address of the printer.
IPX Address — Enter the IPX address of the printer. This is available only when 
the IPX/SPX protocol and Novell Client are installed in your computer, and the 
computer is connected to the NetWare server.
Name — Enter the printer name.
Location — Enter the location of the printer.

NOTE: • You must enter “Name” and either “IP Address” or “IPX Address”.
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4. Select the equipment that you want to connect and click [OK].

5. It automatically obtain the network queue in the “Network 
path or queue name” field.

NOTE: • It automatically obtains the IP address of the equipment and the queue name speci-
fied by an administrator, in the “Network path or queue name” field in the General
submenu page of the Setup menu in the TopAccess administrator mode.  If you can-
not obtain the queue name, ask your administrator that the “Network path or queue
name” field is correctly specified.

6. Continue the installation from step 10 on page 16.

Installing from TopAccess
If the system administrator has uploaded the software to this equipment, you can use TopAccess
to install the software on your workstation.
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Installing client software from TopAccess

1. In TopAccess, click the Install Software link at the bottom of 
the screen.

• The Install Client Software page opens.

2. Click the “Install Client2” link to download the installer file.

3. Download the installer file on your desktop by following the 
prompts.

4. Double-click the “InstallClient2.exe” file that you down-
loaded.
• The installer starts and the InstallShield Wizard dialog box appears.

5. Follow the installation procedure using the Client2 CD-ROM 
described in following section.

 P.13 "Installing from Client2 CD-ROM"

Uninstalling the N/W-Fax Driver and Address Book Viewer
The following instructions describe how to uninstall the N/W-Fax driver and Address Book
Viewer.  The uninstallation procedure is different how you installed the client software.
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 P.24 "When Installed Using the Installer"

 P.28 "When Installed Using Add Printer Wizard"

When Installed Using the Installer
When the client software was installed using the Installer in the Client2 CD-ROM or down-
loaded from TopAccess, you can delete all files using the Add/Remove Programs function.
You can uninstall all client software that have installed from the Client2 CD-ROM, or you can
uninstall only the N/W-Fax driver and Address Book Viewer.

 P.24 "Uninstalling the all Client2 Software"

 P.26 "Uninstalling only N/W-Fax Diver and Address Book Viewer"

Uninstalling the all Client2 Software

The following describes an installation on Windows 2000.  The procedure is the same when
other versions of Windows are used.

1. Open “Control Panel” and double-click the “Add/Remove 
Programs” icon.

• The Add/Remove Programs dialog box appears.
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2. Select “TOSHIBA e-STUDIO4511 Series Client2”, “TOSHIBA 
e-STUDIO450 Series Client2”, or “TOSHIBA e-STUDIO280 
Series Client2” and click [Change/Remove].

• The InstallShield Wizard dialog box appears.

3. Select “Remove” and click [Next].

• The Confirm Uninstall dialog box appears.

4. Click [OK].

5. Click [Yes] to delete the setting files.

• Deleting files starts.
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NOTE: • If you want to re-install the client software later, click [No] to remain the setting files.
You can restore the data and settings when you re-install the client software.

6. Select “Yes, I want to restart my computer now.” and click 
[Finish] to restart your computer.

• Some files may be deleted after restarting the computer.

Uninstalling only N/W-Fax Diver and Address Book Viewer

The following describes an installation on Windows 2000.  The procedure is the same when
other versions of Windows are used.

1. Open “Control Panel” and double-click the “Add/Remove 
Programs” icon.

• The Add/Remove Programs dialog box appears.
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2. Select “TOSHIBA e-STUDIO4511 Series Client2”, “TOSHIBA 
e-STUDIO450 Series Client2”, or “TOSHIBA e-STUDIO280 
Series Client2” and click [Change/Remove].

• The InstallShield Wizard dialog box appears.

3. Select “Modify” and click [Next].

4. Uncheck the components that you want to uninstall and click 
[Next].

• Deleting files starts.
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5. Select “Yes, I want to restart my computer now.” and click 
[Finish] to restart your computer.

When Installed Using Add Printer Wizard
When only N/W-Fax driver is installed by Add Printer Wizard, you can uninstall them by delet-
ing the printer icons in the Printers folder.

Deleting the N/W-Fax driver

1. Open “Printers” folder, select the printer icon that you want 
to delete, and press the [Delete] key.
• When using Windows 98/Me or Windows NT 4.0, uninstallation has 

finished.
• When using Windows 2000/XP/Server 2003, continue to the next 

step.

2. Click the [File] menu and select [Server Properties].

• The Print Server Properties dialog box appears.
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3. Display the Drivers tab.  Select the N/W-Fax driver and click 
[Remove].

• The confirmation dialog box appears.

4. Click [OK].

• The N/W-Fax driver is completely deleted.
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3. FAXING FROM CLIENT COMPUTERS
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Faxing from Applications

You can use the N/W-Fax driver option to electronically fax and Internet Fax from your com-
puter to one or more recipients.
In addition, you can select fax properties, fax schedule options, include fax cover sheets and edit
sender information.

NOTES: • Faxing hard-copy documents must be performed as a walk-up function from the
Touch Panel Display.

• The fax transmission using the N/W-Fax driver is available only when the optional
Fax unit is installed.  The Internet Fax transmission using the N/W-Fax driver is
available without the optional Fax unit.

How to Fax using the N/W-Fax Driver
The following outline summarizes the steps for sending a fax from your desktop:
• Create a document.
• Print to Fax Driver.
• Add recipient’s name and fax numbers.
• Select a default cover page (optional).
• Send the fax.

Preparing Documents for Faxing
To see how objects, such as headers, footers, or drawing objects, will be positioned on a fax
page, switch to your applications’ page layout view. If the software application you are using
provides a Print Preview option, you can use it to view your fax before it is sent.

Faxing from Windows Applications
Once you have installed the N/W-Fax driver, you can send the document directly from most
Windows applications to send as a fax and Internet Fax.
You can print using the various functions by setting print options on the printer driver.

Faxing from Windows applications

1. Open a file and select [Print] from the [File] menu of the appli-
cation.
• The Print dialog box appears.

For e-STUDIO450 Series and e-STUDIO280 Series:
• Fax transmission using the N/W-Fax driver is available only when the Printer Kit or

Printer/Scanner Kit is installed in addition to optional Fax unit.
• Internet Fax transmission using the N/W-Fax driver is available only when the Printer Kit

and Scanner Upgrade Kit are installed, or when the Printer/Scanner Kit is installed.
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2. Select “TOSHIBA e-STUDIO Series Fax” and Click [Proper-
ties].

• The properties dialog box appears.

SUPPLEMENT: • The procedures for displaying the properties dialog for the printer driver may be dif-
ferent depending on an application that you are using. See your application’s man-
ual about displaying the printer properties dialog box.

3. Display the Send tab and specify the recipients, and other 
options.

 P.35 "Setting up the Send Properties"
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4. Display the Cover Sheet tab and specify the cover sheet prop-
erties if you want to send a document with a fax cover sheet.

 P.42 "Setting up the Cover Sheet Properties"

5. Display the Sender Information tab and specify the sender 
information message if you want to appear the message on 
the fax cover sheet.

 P.43 "Setting up the Sender Information Properties"

6. Click [OK] to save the settings.

7. Click [OK] or [Print] to send a document.

SUPPLEMENT: • You can monitor and manage the fax job that is sent from your computer using
TopAccessDocMon and TopAccess.

 P.47 "Managing Faxes"

Setting up the N/W-Fax Options
N/W-Fax options are the attributes you set to define the way a fax job is transmitted.  For exam-
ple, you can specify the recipients, resolution, and paper size.
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SUPPLEMENT: • To find the fax transmission instructions of that you expect for transmission results,
you can refer to the procedures in the following section.

 P.43 "Sending with Extended Fax Functionality"

Setting up the Send Properties
In the Send tab of the N/W-Fax properties dialog box, you can specify the recipients and how the
fax will be sent.

SUPPLEMENT: • To specify the recipients, you can select from the Address Book or enter the recipi-
ent manually.

 P.36 "Specifying Recipients"

1) To
This displays the specified recipients list.

2) [Select From Address Book]
Click to launch the Address Book Viewer. You can select recipients from the Address Book.

 P.37 "Specifying recipients from Address Book"

3) [New]
Click to add new recipient by entering manually.  The Direct Dial dialog box appears.

 P.40 "Entering a recipient manually"

4) [Remove]
Select a recipient in the “To” list and click this to remove the recipient from the list.

 P.41 "Removing recipients"

5) Resolution
Select the resolution for the fax.
• Standard (200 x 100 dpi) — Select this to send a document in Standard mode (200 x

100 dpi).
• Fine (200 x 200 dpi) — Select this to send a document in Fine mode (200 x 200 dpi).
• Super Fine (200 x 400 dpi) — Select this to send a document in Super Fine mode (200

x 400 dpi).
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• Ultra Fine (400 x 400 dpi) — Select this to send a document in Ultra Fine mode (400 x
400 dpi).

6) Dept. Code
Enter 5-digit department code if required.  When the department code is enabled on this
equipment, you must enter the department code to send a fax.

NOTE: • If you do not enter the department code when the department code is enabled on
the equipment and the Department Code Enforcement is set to OFF in TopAccess,
the job will be stored in the Invalid job list without transmitting the job.  You can
release or delete the job that is stored in the Invalid job list from the [JOB STATUS]
button on the Control Panel.  For instructions on how to release or delete the job in
the Invalid job list, see Operator’s Manual for Facsimile Function.

7) Paper Size
Select the paper size of your document.

8) Orientation
Select the orientation of your document.

9) Save as File
Check this to save the fax as file as well as sending a fax and Internet Fax to the recipients.
The fax will be saved in the “TXFAX” folder in the “FILE_SHARE” folder in this equip-
ment.

 P.43 "Saving a Fax as File"

10) File Format
Select the file format of the document that will be saved.  This option can be selected only
when the “Save as File” box is checked.

11) Delayed Fax
Select whether sending a document now or later.
• Send Fax Now — Select this to send a document immediately.
• Send Fax Later — Select this to send a document on a specified date and time.  When

this is selected, click [Edit] to display the Scheduled Time dialog box and specify the
date and time the job will be transmitted.  The job sent to this equipment will be stored in
the Fax queue until the specified date and time.

— Specifying Recipients
You can specify the recipients following method:

 P.37 "Specifying recipients from Address Book"

 P.40 "Entering a recipient manually"
Also you can remove the recipients added to the “To” list.

 P.41 "Removing recipients"
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Specifying recipients from Address Book

1. Click [Select From Address Book] in the Send tab.

• The Address Book Viewer is launched.

2. Browse the address book category within the Address Book 
where desired recipients are programed.

Private Address Book — This contains the contacts registered in the associ-
ated client address book on your client computer.
Public Address Book — This contains the contacts registered in the address 
book in this equipment.
MAPI Address Book — This contains the contacts in the address book of the 
default mail client in your computer.
MS Outlook Express — This contains the contacts in the MS Outlook Express 
address book in your client computer.
LDAP Address Book — This contains the contacts in the specified LDAP server.

SUPPLEMENT: • For more information about the Address Book Viewer, please refer to the Address
Book Viewer Online Help.
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3. Select the contact you want to add as a recipient and click the 
[Fax] icon ( ) in the tool bar to add the fax number as a 
recipient, and click the [Mail] icon ( ) to add the e-mail 
address as a recipient.

• Repeat until all required recipients are selected.
• When you select the fax number as a destination, the fax number icon 

in front of the name of the contact will be changed to the checked fax 
icon ( ).

• When you select the e-mail address as a destination, the e-mail icon 
in front of the name of the contact will be changed to the checked 
e-mail icon ( ).

SUPPLEMENTS: • You can cancel selecting the fax number or e-mail by selecting the contact and
re-clicking the [Fax] or [Mail] icon in the tool bar.

• You can also select the recipient’s fax number by right-click the contact and select
[Select] and [Fax Number] in the menu displayed.

• You can also select the recipient’s e-mail address by right-click the contact and
select [Select] and [EMail] in the menu displayed.
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4. After you selected all recipients,  right-click on a recipient 
name in the right pane and select [Selection] in the menu dis-
played.

• The Destinations dialog box appears.

SUPPLEMENT: • You can also display the Destinations dialog box by clicking the [Selection] icon
( ) in the tool bar.

5. Confirm the destinations that you select in the dialog box.  If 
you remove the destination from the recipients list, select a 
contact and click [Remove].

6. After you confirm the destinations, click [OK].
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7. The Address Book Viewer is closed and selected recipients 
are added to the “To” list.

Entering a recipient manually

1. Click [New].

• The Direct Dial dialog box appears.

2. To add an Internet Fax address as a recipient, select “Internet 
Fax Address” and enter the e-mail address of the recipient in 
the right field.
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3. To add a fax number as a recipient, select “Fax Number” and 
enter the fax number in the right field.  In addition, if you 
specify a Sub address, enter the Sub address in the “SUB” 
field, and security password for the Sub address in the 
“PWD” field if required.

NOTE: • You can send to a fax number only when the optional Fax unit is installed.

4. Click [OK].
• Entered recipient is added to the “To” list.

Removing recipients

1. Select a recipient that you want to delete from the “To” list.

2. Click [Remove].
• The selected recipient is deleted from the “To” list.

For e-STUDIO450 Series and e-STUDIO280 Series:
The Internet Fax transmission using the N/W-Fax driver is available only when the Printer Kit 
and Scanner Upgrade Kit are installed, or when the Printer/Scanner Kit is installed.
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Setting up the Cover Sheet Properties
In the Cover Sheet tab of the N/W-Fax properties dialog box, you can specify the fax cover sheet
to be sent.  If you enable the cover sheet, the cover sheet is attached in the first page of the docu-
ment and sent to the recipients.

1) Cover Sheet
Select the cover sheet type from “Standard Cover Page”, “Business Cover Page”, and “Pro-
fessional Cover Page”.  For cover sheet samples, see the Appendix at the end of this guide.

2) Font Name
Select the font to be used for the cover sheet.

3) Subject
Enter the subject to appear on the cover sheet.  You can enter up to 40 characters.

4) Message
Enter the message to appear on the cover sheet.  You can enter up to 500 characters.

5) Sender Information
Check this to print sender information on the cover sheet.  When this is enabled, specify the
sender information in the Sender Information tab.

 P.43 "Setting up the Sender Information Properties"

6) Recipient Information
Check this to have recipient information appear on the cover sheet.  Select one or more of
the following options to determine what information will appear in the “To:” field of the
cover sheet.
• Name — Check this to have the recipient name appear on the cover sheet.
• Company — Check this to have the recipient company name appear on the cover sheet.
• Department Name — Check this to have the recipient department name appear on the

cover sheet.
• Fax Number — Check this to have the recipient fax number or Internet Fax address

appear on the cover sheet.

7) Reference Number
Enter the reference number to identify the fax.  This number will appear on the cover sheet.
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Setting up the Sender Information Properties
In the Sender Information tab of the N/W-Fax properties dialog box, you can specify the sender
information that appears on the cover sheet.  This must be set only when the “Sender Informa-
tion” box in the Cover Sheet tab is checked.
In the text field in the Sender Information tab, you can enter the up to 500 characters.

Displaying the Version Information
In the About tab of the N/W-Fax properties dialog box, you can display the version information
of the N/W-Fax driver.

Sending with Extended Fax Functionality

Saving a Fax as File
You can save a document in the “TXFAX” folder in the “FILE_SHARE” folder in this equip-
ment as well as sending the document to fax numbers and Internet Fax addresses.

Saving a fax to the default box

1. Display the Send tab and check the “Save as File” box.
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2. Select the file format in the “File Format” drop down box.

3. Specify the other options to send a document and click [OK].

4. Click [Print] to send a document to this equipment.

Delayed Transmission
When the delayed transmission is specified, the fax is stored in the fax queue in this equipment
and will be sent on the specified date and time.

Sending a document on specific date and time

1. Display the Send tab and select “Send Fax Later” in the 
“Delayed Fax” drop down box.

2. Click [Edit].
• The Scheduled Time dialog box appears.

3. Select the date and time and click [OK].

• You can click the Date arrow to display a calendar then allows you to 
select an date.

• Enter the time to commence the fax transmission. You can use the up 
and down arrows to assist with setting the time with the proper format.

NOTE: • The scheduled date cannot be more then one month from the current date.  If the
current month does not have a date like the current date, then the date will be set at
the last day of the following month. For example, if the current date is March 31st.
then the maximum date that can be selected for the scheduled fax is April 30th.

4. Specify the other options to send a document and click [OK].

5. Click [Print] to send a document to this equipment.
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Sending with a Cover Sheet
You can choose to send a cover sheet with your fax transmission. The cover sheet is merged with
the recipient “To” list data to create a fax cover sheet. You can select what to include on the
cover sheet such as sender or recipient information.

Preparing the cover sheet

1. Display the Cover Sheet tab and select the cover sheet type 
in the “Cover Sheet” drop down box.

• For samples of the cover sheets, see the Appendix at the end of this 
guide.

 P.100 "Cover Sheet Samples"

2. Select the font in the “Font Name” drop down box.

• The selected font applies to the text contents in the cover sheet.

3. Enter the subject to appear on the cover sheet in the “Sub-
ject” field.

• You can enter up to 40 characters for the subject.

4. Enter the message to appear on the cover sheet in the “Mes-
sage” field.

• You can enter up to 500 characters for the message.

5. If you want the sender information to appear on the cover 
sheet, check the “Sender Information” box.
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• If you check this, click the Sender Information tab and enter the 
sender information in the text box.  You can enter up to 500 charac-
ters in the sender information text box.

6. If you want the recipients information to appear on the cover 
sheet, check the “Recipients Information” box and check the 
items required for the recipient information.

Name — Check this to have the name of the recipient appear on the cover sheet.
Company — Check this to have the company name of the recipient appear on 
the cover sheet.
Department Name — Check this to have the department name of the recipient 
appear on the cover sheet.
Fax Number — Check this to have the fax number or Internet Fax address of the 
recipient appear on the cover sheet.

NOTES: • Recipients information is obtained from the address book.  If the recipient is added
manually, this information does not appear on the cover sheet except for the fax
number or Internet Fax address.

• The recipients information for all recipients will appear on the cover sheet.

7. If you want the reference number to identify the document to 
appear on the cover sheet, check the “Reference Number” 
box and enter the reference number in the field.

• You can enter up to 20 characters for the reference number.

8. Specify the other options to send a document and click [OK].

9. Click [Print] to send a document to this equipment.

Download from Www.Somanuals.com. All Manuals Search And Download.



Network Fax Guide — Managing Faxes 47

Managing Faxes

You can display manage the fax jobs using TopAccessDocMon and TopAccess.
 P.47 "Managing Fax Jobs using TopAccessDocMon"

 P.48 "Managing Fax Jobs using TopAccess"

Managing Fax Jobs using TopAccessDocMon
Users can use the TopAccessDocMon application’s Fax tab to display the fax jobs that are cur-
rently on this equipment. This page allows the users to display and delete fax jobs which are
originally submitted from your computer. For further information on TopAccessDocMon instal-
lation and configuration, refer to the Printing Guide.

Displaying and deleting the fax jobs using TopAccessDocMon

1. Right-click the TopAccessDocMon icon in the task bar, and 
select [TopAccessDocMon].

• The TopAccessDocMon window appears and displays the Device tab 
that shows the device information of the default printer.

2. If displayed device information is not the device which you 
want to monitor the fax jobs, click the [Printer] menu and 
select the device name in the [Change Device] menu.

• The TopAccessDocMon window displays the device information of 
selected device.
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3. Click the Fax tab.

• The fax jobs list is displayed.

4. If you want to delete a fax job, select a fax job in the list, click 
the [Document] menu and select [Cancel].
• The selected job is deleted.

Managing Fax Jobs using TopAccess
Users can use TopAccess to display the fax jobs that are currently on this equipment. The Fax/
Internet Fax menu page in the Jobs tab allows the users to display and delete fax jobs that are
currently stored in the queue.

Displaying and deleting the fax jobs using TopAccess

1. Access TopAccess using the browser.
• For the instruction to access TopAccess, please refer to the Network 

Operator’s Guide.

2. Click the Job Status tab and Fax/Internet Fax menu.

• The Fax/Internet Fax menu page displays the list of fax jobs.
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3. If you want to delete a fax job, select a option box of the fax 
job in the list, and click [Delete].
• The selected fax job is deleted.
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4. MANAGING ADDRESS BOOK
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Running Address Book Viewer

The Address Book Viewer allows you to manage the Address Book properties, manage address
books and address book entries. Particularly, you can perform the following functions:
• Create new contacts
• Create Address Book groups
• Modify contact information
• Search the address book database
• Import Address Book data
• Export Address Book data

Running the Address Book Viewer
You can access the Address Book Viewer using two methods:
• Programs folder in the Start menu
• Print Properties window of the N/W-Fax driver (limited accessibility)

Access Using Program Group
From the Program Group, you can access the Address Book Viewer to create and edit your pri-
vate address book.

Accessing the Address Book Viewer from the Programs group

1. Click the [Start] menu, select [Programs], [TOSHIBA e-STU-
DIO Client], and select [TOSHIBA e-STUDIO Address Book].

• The Address Book Viewer window appears.

Access Using Print Properties
From the Print window, you can limitedly create and edit contacts in the Address Book. 

NOTE: • This method is only suggested if you are in the process of sending a fax and you
need to add a fax recipient to the send list that is not currently a member of the
Address Book. Otherwise, use the program group to access the Address Book
Viewer.
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Accessing the Address Book Viewer from the Print properties

1. In the Print dialog box in the application, select the N/W-Fax 
driver for the printer and click [Properties].

• The N/W-Fax properties dialog box appears.

2. Click [Select From Address Book] in the Send tab.

• The Address Book Viewer window appears.

— Selecting Contacts for N/W-Fax
When you access the Address Book Viewer from the N/W-Fax driver, it allows you to select the
contacts from the Address Book Viewer.
After you select contacts that you want to add as recipients, right-click on a recipient name in the
right pane and select [Selection] in the context sensitive menu.

SUPPLEMENT: • You can also select the recipients by searching the contacts in the Address Book
Viewer.

 P.87 "Searching Contacts"

Download from Www.Somanuals.com. All Manuals Search And Download.



54 Network Fax Guide — Running Address Book Viewer

Then the Destinations dialog box appears.

• [Remove] — Click this to remove the selected contacts from the destinations list.
• [OK] — Click this to add these contacts as the destinations.
• [Cancel] — Click this to cancel the selection.
• [Help] — Click this to display the online Help.

About Address Book Viewer Interface
The Address Book Viewer main window consists of following items.

1) Menu Bar
You can perform various functions by selecting a command from the menus.

 P.55 "Menu Bar"
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2) Toolbar
You can perform general functions quickly by clicking a icon in the tool bar.

 P.57 "Toolbar"

3) Browse Pane
You can expand or collapse to view/hide Groups and Contact address book entries.
The browse pane contains a tree structure for the following address books:
• Private Address Book — This contains the contacts registered in the associated client

address book on your client computer.
• Public Address Book — This contains the contacts registered in the address book in

this equipment.
• MAPI Address Book — This contains the contacts in the address book of default mail

client in your computer.
• MS Outlook Express — This contains the contacts in the MS Outlook Express address

book in your client computer.
• LDAP Address Book — This contains the contacts in specified LDAP server.

4) Contents Pane
The right-hand pane displays non-modifiable, text-only summary information about the cur-
rently selected address book entry.  Selecting an entry in the browse pane of the address
book displays summary information about the entry in the contents pane. 

5) Status Bar
This displays the description of selected command in the left side, and the number of the
items of the currently selected address book entry in the right side.

Using Commands
Address Book Viewer allows you to perform a wide variety of functions.
You can access all of the commands from menus in the menu bar and from the icons in the tool
bar at the top of the Address Book Viewer window.  You can also choose commands from con-
text-sensitive menus by right-clicking the browse pane and contents pane.

Menu Bar
The menu bar contains five menus of commands that allow you to perform various functions in
Address Book Viewer.

1) File menu
• New Contact — Select this to add new contact in the private address book.  If the cur-

rently selected item is a group, the contact will be created as a member of the group.  If
the currently selected item is the “Location/People” folder or “Private Address Book”
object, the contact will be created in the "Location/People" folder.  This command is
available only when selecting items in the object in the private address book.

• New Group — Select this to add new group in the private address book.  This command
is available only when selecting the “Group” folder in the private address book.

• Properties — Select this to edit or display the properties of a group or a contact in the
private or public address book.  This command is available only when selecting a group
or a contact in the private or public address book.

• Delete — Select this to delete a group or contacts in the private address book.  This com-
mand is available only when selecting a group or contacts in the private address book.

• Download — Select this to download the public address book from this equipment.
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• Import -CSV File — Select this to import the address book data that had been exported
as CSV files from e-STUDIO4511 Series, e-STUDIO450 Series, e-STUDIO280 Series,
GL-1010 address book using the Address Book Viewer.  Imported address book appears
in the left pane as “Imported Address Book” and it disappears next time you run the
Address Book Viewer.

NOTE: • The Address Book Viewer can import a CSV file that was originally exported from
the Address Book Viewer.  Also the Address Book Viewer cannot be imported a
CSV file that has been modified.

• Import -vCard File — Select this to import the address book data that had been
exported as vCard files from e-STUDIO4511 Series, e-STUDIO450 Series,
e-STUDIO280 Series, GL-1010 address book using the Address Book Viewer.
Imported address book appears in the left pane as “Imported Address Book” and it dis-
appears next time you run the Address Book Viewer.  This command is available only
when Microsoft Office XP is installed on your computer.

• Export - CSV File — Select this to export the selected address book as a CSV file.
• Export - vCard File — Select this to export the selected address book as a vCard file.

This command is available only when Microsoft Office XP is installed on your com-
puter.

• Exit — Select this to exit the Address Book Viewer.

2) Edit menu
• Copy — Select this to copy the selected contacts or a group in the clipboard.  The con-

tacts or a group copied in the clipboard can be pasted in the private address book.  This
item is available only when selecting a group or contacts in any address book.

• Paste — Select this to paste the contacts or a group copied in the clipboard in the private
address book.  If the group has been copied, this item is available only when selecting
the “Group” folder.  If the contacts have been copied, this item is available only when
selecting a group or the “Location/People” folder in the private address book.

• Select All — Select this to select all contacts displayed in the right pane.  This item is
available only when browsing groups or contacts.

• Find — Select this to find a contact by searching the address book.  You can also search
the LDAP server to add the contacts in the LDAP Address Book.

3) View menu
• Toolbar — Select this to display or hide the toolbar.  When the check mark appears in

the menu, the toolbar is currently displayed.  You can select it again to hide the toolbar.
• Status Bar — Select this to display or hide the status bar.  When the check mark appears

in the menu, the status bar is currently displayed.  You can select it again to hide the sta-
tus bar.

• Large Icons — Select this to display the contacts using large icons.
• Small Icons — Select this to display the contacts using small icons.
• List — Select this to display the contacts in a list.
• Details — Select this to display the contacts in a list with detailed information.
• Sort By - Name — Select this to sort the contacts alphabetically by the name.
• Sort By - Fax Number — Select this to sort the contacts alphabetically by the fax num-

ber.
• Sort By - Email Address — Select this to sort the contacts alphabetically by the e-mail

address.
• Sort By - Ascending — Select this to sort the contacts alphabetically in ascending order.
• Sort By - Descending — Select this to sort the contacts alphabetically in descending

order.
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4) Tools menu
• LDAP Setting — Select this to configure the LDAP service to obtain the LDAP address

book from the LDAP server.
• Device Setting — Select this to find the device to obtain the public address book from

this equipment.
• Converting — Select this to run the Address Book Converter.  Using the Address Book

Converter, the address book file of the GL-1010 or GL-1020 that can be created using
TopAccess can be converted to the address book file that can be restored or imported to
e-STUDIO4511 Series, e-STUDIO450 Series, and e-STUDIO280 Series.  This com-
mand is available only for Windows NT 4.0, Windows 2000, Windows XP, and Win-
dows Server 2003.

5) Help
• Contents and Index — Select this to display the Online Help.
• About TOSHIBA e-STUDIO Address Book — Select this to display the version infor-

mation.

Toolbar
You can use following tool icon to perform various functions quickly.

 (New Contact) — Click this to add new contact in the private address book.  If the cur-
rently selected item is a group, the contact will be created as a member of the group.  If the cur-
rently selected item is a contact or the address book, the contact will be created in the address
book.  This icon is available only when selecting items in the private address book.

 (New Group) — Click this to add new group in the private address book.  This icon is
available only when selecting the “Group” folder in the private address book.

 (Copy) — Click this to copy the selected contacts or a group in the clipboard.  The con-
tacts or a group copied in the clipboard can be pasted in the private address book.  This icon is
available only when selecting a group or contacts in any address book.

 (Paste) — Click this to paste the contacts or a group copied in the clipboard in the private
address book.  If the group has been copied, this item is available only when selecting the
“Group” folder.  If the contacts have been copied, this item is available only when selecting a
group or "Location/People" folder in the private address book, and selecting a group or “One
Touch” folder in the public address book.

 (Properties) — Click this to edit or display the properties of a group or a contact.  This
icon is available only when selecting a group or a contact.

 (Delete) — Click this to delete a group or contacts in the private address book.  This icon
is available only when selecting a group or contacts in the private address book.

 (Find) — Click this to find a contact by searching the address book.

 (Download) — Click this to download the public address book that you modified to this
equipment.

 (Fax) — Click this to add the fax numbers of selected contacts as destinations to be sent
using the N/W-Fax driver.  This icon is available only when accessing the Address Book Viewer
from the N/W-Fax driver properties dialog box and selecting contacts.
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 (Mail) — Click this to add the e-mail addresses of selected contacts as destinations to be
sent using the N/W-Fax driver.  This icon is available only when accessing the Address Book
Viewer from the N/W-Fax driver properties dialog box and selecting contacts.

 (Confirm Selection) — Click this to display the Destinations dialog box to confirm the
destinations to be sent using the N/W-Fax driver.  This icon is available only when accessing the
Address Book Viewer from the N/W-Fax driver properties dialog box and any fax numbers or
e-mail addresses have been selected as destinations.

Context-Sensitive Menus
You can also use the context-sensitive menu that is displayed by right-click the Address Book
Viewer window.
The context-sensitive menu contains different commands when you right-click the left pane or
right pane.

— Context-Sensitive Menu on Browse Pane (Left Pane)
Following menus are displayed when right-clicking on the left pane.
• Add - Contact — Select this to add new contact in the private address book.  If the currently

selected item is a group, the contact will be created as a member of the group.  If the cur-
rently selected item is the "Location/People" or the private address book folder, the contact
will be created in the "Location/People" folder.  This command is available only when
selecting items in the private address book.

• Add - Group — Select this to add new group in the private address book.  This command is
available only when selecting the “Group” folder in the private address book.

• Copy — Select this to copy the selected group in the clipboard.  The group copied in the
clipboard can be pasted in the private address book.  This item is available only when select-
ing a group in any address book.

• Paste — Select this to paste the contacts copied in the clipboard in the private address book.
This item is available only when selecting a group or the “Location/People” folder in the pri-
vate address book.

• Properties — Select this to edit or display the properties of a group.  This command is avail-
able only when selecting a group.

• Delete — Select this to delete a group in the private address book.  This command is avail-
able only when selecting a group in the private address book.

— Context-Sensitive Menu on Contents Pane (Right Pane)
Following menus are displayed when right-clicking on the right pane.
• Add — Select this to add new contact in the private address book.  If the currently selected

item is a group, the contact will be created as a member of the group.  If the currently
selected item is the "Location/People" or the private address book folder, the contact will be
created in the "Location/People" folder.  This command is available only when selecting
items in the private address book.

• Copy — Select this to copy the selected contacts in the clipboard.  The contacts copied in
the clipboard can be pasted in the private address book.  This item is available only when
selecting contacts in any address book.

• Paste — Select this to paste the contacts copied in the clipboard in selected group or "Loca-
tion/People" folder of the private address book.  This item is available only when selecting a
group or "Location/People" folder in the private address book.

• Properties — Select this to edit or display the properties of a contact in the private address
book.  This command is available only when selecting a contact in the private address book.
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• Delete — Select this to delete contacts in the private address book.  This command is avail-
able only when selecting contacts in the private address book.

• Select - Fax Number — Select this to add the fax numbers of selected contacts as destina-
tions to be sent using the N/W-Fax driver.  This item is available only when accessing the
Address Book Viewer from the N/W-Fax driver properties dialog box and selecting contacts.

• Select - EMail — Select this to add the e-mail addresses of selected contacts as destinations
to be sent using the N/W-Fax driver.  This item is available only when accessing the Address
Book Viewer from the N/W-Fax driver properties dialog box and selecting contacts.

• Selection — Select this to display the Destinations dialog box to confirm the destinations to
be sent using the N/W-Fax driver.  This item is available only when accessing the Address
Book Viewer from the N/W-Fax driver properties dialog box and any fax numbers or e-mail
addresses have been selected as destinations.
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Managing Address Book

You can use the Address Book Viewer to manage the private address book, that you can add or
edit the contacts and groups as you prefer.  The private address book data is stored in your client
computer, so that it can be used to manage the contacts and groups for sending a fax or Internet
Fax using the N/W-Fax driver.
The Address Book Viewer also display the public address book that is the address book in the
compatible TOSHIBA equipment, such as e-STUDIO4511 Series, e-STUDIO450 Series,
e-STUDIO280 Series, and GL-1010 controller for the e-STUDIO35/45.  Using the Address
Book Viewer, you can display the contacts or groups in the address book and they can be copied
to your private address book.
In addition, you can access the address book data such as other address book application of the
default e-mail client in your computer, Microsoft Outlook Address Book, and LDAP directory
service running in your network.  You cannot add, delete, and edit the data in these address book,
but you can copy their address book data to paste these data into the private address book.

About the Address Books
You can manage your address book using following address books:
• Private Address Book can be used as your own address book.

 P.61 "Managing the Public Address Book"

• Public Address Book allows you to display the address book in e-STUDIO4511 Series,
e-STUDIO450 Series, e-STUDIO280 Series, and GL-1010 controller for the e-STUDIO35/
45.

 P.61 "Managing the Public Address Book"

• MAPI Address Book allows you to display the address book data of the default e-mail appli-
cation in your computer.

 P.66 "Configuring the MAPI Address Book"

• MS Outlook Address Book allows you to display the address book data of Microsoft Out-
look Express in your computer.

 P.67 "Managing the Microsoft Outlook Address Book"

• LDAP Address Book allows you to display the address book data which is added from the
LDAP servers.

 P.67 "Managing the LDAP Address Book"
Also the Address Book Viewer allows users to import and export the address book data as CSV
file or vCard file, so that users can import the CSV file or vCard file which exported from
another user’s private address book or public address book, and users can export the private
address book and public address book for other users.

 P.73 "Importing and Exporting the Address Book"

NOTE: • Importing and exporting a vCard file is available only when Microsoft Office XP is
installed on your computer.

Managing the Private Address Book
You can manage your own address book using the private address book.  You can add, delete,
and modify the contacts in this address book.  You can also create, delete, and modify the
groups.
Contacts and groups can be added to this address book by various ways using other address
books within the Address Book Viewer.  For the instruction to manage the contacts and groups
in the private address book, please refer to the following section:

 P.75 "Managing Contacts and Groups"
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Managing the Public Address Book
In order to access the public address book in e-STUDIO4511 Series, e-STUDIO450 Series,
e-STUDIO280 Series, and GL-1010 controller for the e-STUDIO35/45, you must configure the
connection to the device.
You can configure the connection by searching the device in the network, or entering the IP
address of the device manually.

 P.61 "Configuring the Connection by Local Discovery"

 P.64 "Configuring the Connection by Manual Selection"
After configuring the connection to the device, the address book data of the device is obtained in
the public address book.  You can display the address book data and copy them in the private
address book.
For the instruction to download the public address book data into the Address Book Viewer,
please refer to the following section:

 P.66 "Downloading the Public Address Book"

— Configuring the Connection by Local Discovery
You can search the device in your network and configure the connection.

Discovering the device

1. Click the [Tools] menu and select [Device Setting].

• The TopAccessDocMon Local Discovery dialog box appears.
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2. Click [Start Discovery] to begin the process.

• It locates all the compatible devices in your network.

SUPPLEMENTS: • You can quit the process by clicking [Stop Discovery].
• If the process continues for a long time, it is because the too many network clients

are in the network.  In this case, you can configure the discovery settings from
[Advanced] button.

 P.63 "Configuring Discovery Settings"

3. When the process completes, found printers are listed in the 
list.

4. Select the device that you want to access from the list and 
click [OK].

• The Address Book Viewer connects to selected device and obtains 
the address book data in the Public Address Book.
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Configuring Discovery Settings
You can configure the discovery settings.

1) Devices
Click the arrow button to display the pull down list and check the model name that you want
to search.

2) Network - Enable IPX/SPX Search
This is disabled because the Address Book Viewer does not support the IPX/SPX connec-
tion.

3) Network - Enable TCP/IP Search
Check on this to search devices that connect to the TCP/IP network.  This is available only
when the TCP/IP protocol is installed in your computer.
When this is enabled, select how it searches printers in the TCP/IP network.
• Search local subnet — Select this to search devices in local subnet.
• Specify a range — Select this to search devices in specific range of IP addresses.  When

this is selected, enter the IP addresses in “From” field and “To” field to specify the
range.
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— Configuring the Connection by Manual Selection
You can configure the connection by entering the IP or IPX address of the device manually.

Configuring the connection manually

1. Click the [Tools] menu and select [Device Setting].

• The TopAccessDocMon Local Discovery dialog box appears.

2. Click [Manual Selection].

• The Manual Selection dialog box appears.
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3. Enter each item to specify the printer address.

IP Address — Enter the IP address of the printer.
IPX Address — This is disabled because the Address Book Viewer does not 
support the IPX/SPX connection.
Name — Enter the printer name.
Location — Enter the location of the printer.

NOTE: • You must enter “Name” and either “IP Address” or “IPX Address”.

4. Click [OK].
• Entered device is added to the list in the TopAccessDocMon Local 

Discovery dialog box.

5. Select the entered device name and click [OK].

• The Address Book Viewer connects to entered device and obtains the 
address book data in the Public Address Book.
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— Downloading the Public Address Book
You can download the address book data in the equipment to the Address Book Viewer.

Downloading the public address book data

1. Click the [File] menu, select [Download], and select the 
device name that you want to download the address book.

2. The Downloading dialog box appears.  You can quit down-
loading the address book data by clicking [Cancel].

• The public address book data is downloaded from the selected 
device.

Configuring the MAPI Address Book
The Address Book Viewer automatically access to the address book application of the default
e-mail client software using the Messaging API (MAPI).
If the Address Book Viewer prompts an error message when selecting the MAPI Address Book,
the default e-mail client software has not been defined in your computer, or the default e-mail
software does not support MAPI.  In this case, set the MAPI-compliant e-mail software as
default e-mail client.  For the instruction to set your e-mail application as default e-mail client,
refer to the documentation or online help of your e-mail application.
You can use the MAPI address book to copy the contacts and groups to the private address book.

 P.79 "Copying Contacts from an Address Book"
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Managing the Microsoft Outlook Address Book
The Address Book Viewer automatically access to the Microsoft Outlook Express Address Book
to obtain the address book data.  You use the MS Outlook address book to copy the contacts and
groups to the private address book.

 P.79 "Copying Contacts from an Address Book"

Managing the LDAP Address Book
In order to access to the address book data in the LDAP servers, first you must register the
LDAP directory services that you want to access.

 P.67 "Registering the LDAP Directory Services"
Then search contacts in the LDAP server and add the contacts to the LDAP Address Book.

 P.69 "Adding Contacts from LDAP Servers"
You can use the LDAP address book to copy the contacts to the private address book.

 P.79 "Copying Contacts from an Address Book"

— Registering the LDAP Directory Services
You can register multiple LDAP directory services.

Registering the LDAP directory services

1. Click the [Tools] menu and select [LDAP Setting].

• The Internet Account dialog box appears.
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2. In the General tab, enter the items as described below.

Directory Server Address or IP — Enter the server name or IP address of a 
LDAP server.
This Server requires me to log on — Check this if the LDAP server requires 
the user name and password to log on.
Account Name — Enter the user name to log on the LDAP server.
Password — Enter the password to log on the LDAP server.
Log on using Secure Password Authentication — Check this to use secure 
password to log on the LDAP server.
Character code setting — Select the character code for the LDAP server.

3. In the Advanced tab, enter the items as described below.

Server Port Number - Directory service (LDAP) — Enter the port number to 
access the LDAP server.  It shows “389” as a default.  Change this number if you 
are sure the LDAP port number is changed from the default port number on the 
LDAP server.
Server Port Number - This Server requires a secure connection (SSL) — 
Check this when you require to access the LDAP server using SSL.
Search - Search timeout — Select the timeout interval for searching.
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Search - Maximum number of matches to return — Select maximum numbers 
for the search results.
Search - Search Base — Enter the search root suffix.

4. Click [Add].
• The entered directory service is added to the Directory Service list.

5. Repeat the procedure from Step 2 to Step 3 until all required 
directory services are added.

— Adding Contacts from LDAP Servers
After you register the LDAP directory services, you can search contacts in the LDAP servers
and add preferred contacts to the LDAP Address Book.
You can search contacts by the name, fax number, and e-mail address.  Also you can search con-
tacts by specifying the detailed search conditions.

Searching contacts by name, fax number, and e-mail address

1. Click the [Edit] menu and select [Find].

• The Find Contact dialog box appears.

2. Select a registered directory service in the “Data Source” 
drop down box.
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3. Display the Person tab and enter search text in the following 
fields that you require.

Name — Enter the search characters or string to search by the contact name.
Fax Number — Enter the search characters or string to search by the contact fax 
number.
E-Mail — Enter the search characters or string to search by the contact e-mail 
address.

NOTE: • You must enter data into one of the fields to search contacts.  It will search the con-
tacts that contain the entered search strings.

SUPPLEMENT: • If you want to clear entered values, click [Clear All].

4. Click [Search].
• It begins searching contacts in the LDAP server.  When it completes 

searching, found contacts appears in the list at the bottom of the dia-
log box.

SUPPLEMENT: • If you want to stop searching, click [Stop].

5. Select contacts that you want to add to the LDAP Address 
Book, and click [Add].

Download from Www.Somanuals.com. All Manuals Search And Download.



Network Fax Guide — Managing Address Book 71

• The selected contacts are added to the LDAP Address Book.

Searching contacts by detailed search conditions

1. Click the [Edit] menu and select [Find].

• The Find Contact dialog box appears.

2. Select a registered directory service in the “Data Source” 
drop down box.

3. Display the Detail Setting tab and select a field to search in 
the “Field Select” drop down box.

4. Select how it searches contacts in the “Condition of search 
string” drop down box.

Contains — Select this to search contacts that contain the search string.
Is — Select this to search contacts that completely match the search string.
Start with — Select this to search contacts that start with the search string.
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End with — Select this to search contacts that end with the search string.

5. Enter the search string in the next field to the “Condition of 
search string” drop down box.

6. Click [Add].
• Specified search condition is added to the condition list.

SUPPLEMENT: • If you want to clear entered values, click [Clear All].

7. Repeat the procedure from Step 3 to Step 6 to add all required 
conditions.

SUPPLEMENT: • You can remove the search conditions you have added.  To do this, select the condi-
tion and click [Delete].

8. Click [Search].
• It begins searching contacts in the LDAP server.  When it completes 

searching, found contacts appear in the list at the bottom of the dialog 
box.

SUPPLEMENT: • If you want to stop searching, click [Stop].

9. Select contacts that you want to add to the LDAP Address 
Book, and click [Add].

• The selected contacts are added to the LDAP Address Book.
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Importing and Exporting the Address Book
The Export feature of the Address Book Viewer allows you to create a CSV file or vCard file of
your selected address book, and it can be imported to other user’s Address Book Viewer.  The
Import/Export feature is useful when users want to share the address book data.

NOTES: • Do not modify the CSV file that is exported from the Address Book Viewer.  Once
you modify the CSV file, it cannot be imported to the Address Book Viewer.

• Importing and Exporting a vCard file is available only when Microsoft Office XP is
installed on your computer.

Also you can use the import address book to copy the contacts and groups to the private address
book.

 P.79 "Copying Contacts from an Address Book"

Importing the address book from a CSV file or vCard file

1. Click the [File] menu and select [Import] and [CSV File] or 
[vCard File].

• The Importing dialog box appears.

NOTE: • The [vCard File] command will appear only when Microsoft Office XP is installed on
your computer.
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2. Locate the folder where the CSV file or vCard file is stored, 
and select the file type (CSV or vCard) in the “Files of type” 
drop down box.  Then select the file and click [Open].

3. The address book data is imported and “Import Address 
Book” is added in the left pane.

• If you have already been import an address book before, contacts 
information is added to the existing import address book.

SUPPLEMENT: • If one or more records have been skipped during the import process, it may be due
to one of following reasons:
- Record already exists.
- Group name contains an invalid character.
- Fax number is invalid.
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Exporting the address book as a CSV file or vCard File

1. Click the [File] menu and select [Export] and [CSV File] or 
[vCard File].

• The Exporting dialog box appears.

NOTE: • The [vCard File] command will appear only when Microsoft Office XP is installed on
your computer.

2. Locate the folder where you want to save the CSV file or 
vCard File, and select the file type (CSV or vCard) in the 
“Save as type” drop down box.  Then enter the file name and 
click [Save].

• The private address book is exported as a CSV file or vCard file.

Managing Contacts and Groups
Users can create contact and group entries to the private address book that can be accessed from
your desktop.
Under the Private Address Book folder, there are two containers, “Group” and “Location/Peo-
ple”.
The “Location/People” folder contains individual contact information.  The Group folder con-
tains the groups and it can contain the individual contact information in each group.
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Managing Contacts
You can add contacts to the “Location/People” folder and each created groups in the Private
Address Book.
There are several ways to add the contact to the container.

 P.76 "Adding Contacts Manually"

 P.79 "Copying Contacts from an Address Book"
Also you can modify or delete contacts in the private address book.

 P.80 "Displaying or Modifying Contacts Properties"

 P.83 "Removing Contacts"

— Adding Contacts Manually
You can add new contacts to the “Location/People” folder in the private address book.  Also you
can add new contacts to groups created in the private address book.

Adding a new contact manually

1. Select the folder that you want to add new contact in the left 
pane.

• If you want to add new individual contact in the private address book, 
select the “Location/People” folder under “Private Address Book” 
folder.

• If you want to add new contact to the group in the private address 
book, select a group that you want to add a contact in the “Group” 
folder under “Private Address Book” folder.
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2. Click the [File] menu and select [New Contact].

• The New Contact dialog box appears.

3. In the Personal tab, enter items as described below.

One Touch ID — Select the one touch ID number for the contact (if desired).
Prefix — Select the prefix for the contact.
First Name — Enter the first name of the contact.  You can enter up to 32 char-
acters.
Last Name — Enter the last name of the contact.  You can enter up to 32 charac-
ters.
Suffix — Select the suffix for the contact.
Display Name — The display name is automatically entered as “[Prefix] [First 
Name] [Last Name] [Suffix]”.  You can also edit the name as you prefer.  You can 
enter up to 100 characters.
Company — Enter the company name of the contact. You can enter up to 64 
characters.
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Department — Enter the department name of the contact.  You can enter up to 
64 characters.
Fax — Enter the 1st fax number of the contact.  You can enter up to 128 charac-
ters includes numbers and the following symbols: +, -, [space], *, #
To add a 3 second pause to a fax telephone number, place a hyphen (-) at the 
desired point in the number.
Second Fax — Enter the 2nd fax number of the contact.  You can enter up to 
128 characters includes numbers and the following symbols: +, -, [space], *, #
To add a 3 second pause to a fax telephone number, place a hyphen (-) at the 
desired point in the number.
E-mail Address — Enter the e-mail address of the contact.  You can enter up to 
192 characters with at least one @.
Notes — Enter the notes for the contact.  You can enter up to 256 characters.

NOTE: • You must enter “Last Name” and either “First Tel” or “E-mail Address”.

4. In the Sending Options tab, enter items as described below 
as required.

Use Sub Address and sender information — Check this to enable subaddress 
transmission for this contact.  When this is checked, documents will be always 
sent using the specified sub address and SID.  Also you can use this contact to 
perform polling transmission from the mailbox in the remote facsimile using the 
specified sub address and password.
Sub Address — Enter the sub address or mailbox number of remote facsimile 
where a document will be sent.  This can be entered only when “Use Sub 
Address and sender information” is enabled.
Sender Identification — Enter the security password for the sub address if 
required.  This can be entered only when “Use Sub Address and sender informa-
tion” is enabled.

NOTE: • Other items in this tab cannot be modified.

5. Click [OK].
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• The contact is added to the list in the selected folder.

— Copying Contacts from an Address Book
You can also add contacts to the private address book and public address book by copying con-
tacts from another address book folder.

Copying contacts from another address book folder

1. Browse to the folder that contains the contacts you want to 
copy, and select the contacts in the right pane.

2. Click the [Edit] menu and select [Copy].

• The selected contacts are copied in the clipboard.

3. Select a folder that you want to add the copied contacts in the 
left pane.
• If you want to copy individual contacts in the private address book, 

select the “Location/People” folder under “Private Address Book” 
folder.

• If you want to copy contacts to the group in the private address book, 
select a group that you want to add contacts in the “Group” folder 
under “Private Address Book” folder.

• If you want to copy individual contacts in the public address book, 
select the “One Touch” folder under “Public Address Book” folder.

• If you want to copy contacts to the group in the public address book, 
select a group that you want to add a contact in the “Group” folder 
under “Public Address Book” folder.
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4. Click the [Edit] menu and select [Paste].

• Copied contacts are added to the list in the selected folder.

— Displaying or Modifying Contacts Properties
You can display the properties of contacts in any address book.  You can also edit the properties
of contacts in the private address book.

Displaying or modifying the contact properties

1. Browse to the folder that contains the contacts you want to 
display or modify, and select the contact in the right pane.

2. Click the [File] menu and select [Properties].

• The Properties dialog box appears.

In the Properties dialog box, you can modify the settings of the contacts in the private address
book only.  When you display the Contact dialog box of the contacts in any other address books,
you cannot modify the settings.
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The Properties dialog box contains the Personal tab, Sending Options tab, and Security tab.

SUPPLEMENT: • The tabs that will be displayed vary based on the type of the address book that the
contact is chosen from.

Personal Tab
In the Personal tab, following items are displayed:

SUPPLEMENT: • When displaying the properties of a contact in the private address book, you can
modify all items.

• One Touch ID — Display the one touch ID number for the contact.
• Prefix — Display the prefix for the contact.
• First Name — Display the first name of the contact.
• Last Name — Display the last name of the contact.
• Suffix — Display the suffix for the contact.
• Display Name — Display the display name of the contact.
• Company — Display the company name of the contact.
• Department — Display the department name of the contact.
• Fax — Display the 1st fax number of the contact.
• Second Fax — Display the 2nd fax number of the contact.
• E-mail Address — Display the e-mail address of the contact.
• Notes — Display the notes for the contact.
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Sending Options tab
In the Sending Options tab, following items are displayed:

SUPPLEMENT: • When displaying the properties of a contact in the private address book, you can
modify the following settings:
- Use Sub Address and sender information
- Sub Address
- Sender Identification

• Use Device Settings — This is checked when the contact is set to use the device settings
rather than using the settings on this tab.

• Use Sub Address and sender information — This is checked when the subaddress trans-
mission for this contact is enabled.  When this is checked, a document will be always sent
using the specified sub address and SID.  Also you can use this contact to perform polling
transmission from the mailbox in the remote facsimile using the specified sub address and
password.

• Sub Address — Display the sub address or mailbox number of remote facsimile where a
document will be sent.

• Sender Identification — Display the security password for the sub address if required.
• Selective Polling — Display the mailbox number of remote facsimile where a document

will be retrieved.
• Password — Display the password for the selective polling if required.
• Overseas Calls — This is checked when calling the contact fax number will be oversea call.
• Error Correction Mode — This is checked when the ECM for this contact is enabled.
• Print Transmission Report — This is checked when printing the transmission report after

the transmission is enabled.
• Reduction — This is checked when the attenuation is enabled.
• Short Protocol — This is checked when the short protocol is enabled.
• Line Monitor — This is checked when the Line Monitor for the fax transmission is enabled.
• Line Selection — Display whether the line 1 or line 2 is used for the fax transmission.  The

line 2 can be selected only when optional Line 2 board is installed.
• Transmission Type — Display whether the memory transmission or direct transmission is

used for the transmission.

Download from Www.Somanuals.com. All Manuals Search And Download.



Network Fax Guide — Managing Address Book 83

• Internet Fax Mode — Display whether the simple mode or full mode is used for the Inter-
net Fax transmission.

• Setting Value — Display whether to use auto detect receiver capability or manual settings
for the Internet Fax transmission.  When “Default” is selected, it enable auto detect receiver
capability for the Internet Fax transmission.  When “Custom” is selected, it uses custom set-
tings specified in the “Receiver Capability” option for the Internet Fax transmission.

• Receiver Capability — Display the receiver capabilities settings, such as resolution, com-
pression, and page width.  These are applied to the transmissions only when “Custom” is
selected in the “Setting Value” option.

Security Tab
In the Security tab, following items are displayed:

• Owner — Display the owner name of this contact.
• Password — Display the password of this contact.
• Editing Date — Display the date that this contact is created.

— Removing Contacts
You can remove contacts from the private address book.

Removing contacts from address book

1. Browse the folder that contains contacts you want to remove, 
and select contacts in the right pane.
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2. Click the [File] menu and select [Delete].

• The Confirmation Deletion dialog box appears.

3. Click [Yes].

• The selected contacts are deleted.

Managing Groups
You can add groups to the “Group” folder in the Private Address Book.  Groups can be used for
multiple transmission.

 P.84 "Creating Groups"
Also you can modify or delete contacts in the private address book.

 P.85 "Modifying Groups Properties"

 P.86 "Removing Groups"
After you create a group, you can add or delete contacts in the group.  For the instruction to add
contacts in a group, please refer to the following section.

 P.76 "Managing Contacts"

— Creating Groups
You can create groups in the “Group” folder in the private address book.

Creating groups

1. Select the “Group” folder either in the “Private Address 
Book” folder.
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2. Click the [File] menu and select [New Group].

• The Group dialog box appears.

3. Enter a group name in the “Group Name” field.

• The “Group ID” field displays the Group ID number automatically 
detected.

4. Click [OK].
• The group is created in the selected “Group” folder.

5. Continue to add contacts to the group.
 P.76 "Managing Contacts"

— Modifying Groups Properties
You can change the group name of the groups in the private address book.  You can also display
the properties of a group in the public address book.
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Modifying the group properties

1. Select the group that you want to display or modify the group 
properties in the “Group” folder either of the private address 
book and public address book.

2. Click the [File] menu and select [Properties].

• The Group dialog box appears.

3. When you display the properties of the group in the private 
address book, modify the group name in the “Group Name” 
field and click [OK].

• The group name of selected group is modified.

NOTE: • You cannot modify the group of the public address book.

— Removing Groups
You can delete groups in the private address book.

NOTE: • When you delete a group, contacts added in the group are also deleted.
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Removing a group

1. Select the group that you want to delete in the “Group” folder 
of the private address book.

2. Click the [File] menu and select [Delete].

• The Confirm Deletion dialog box appears.

3. Click [Yes].

• The selected group is deleted.

Searching Contacts
In order to quickly locate contacts you can search the Address Book database. You simply type
in a string or letters to be used to search the database. The Address Book Viewer will search for
any entry that contains the specified string. For example, you can type Smit and select the
address book to be searched, and all contacts entries in the selected address book that match the
search string Smit will be displayed. Including names like Smit, Smith, Smiths. The search is not
limited to names only.
You can search contacts by the name, fax number, and e-mail address.  Also you can search con-
tacts by specifying the detailed search conditions.

SUPPLEMENT: • If the Address Book Viewer is launched by clicking [Select From Address Book] in
the N/W-Fax driver, you can add the searched contacts as recipients for N/W-Fax.
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Searching contacts by name, fax number, and e-mail address

1. Click the [Edit] menu and select [Find].

• The Find Contact dialog box appears.

2. Select a address book to search contacts in the “Data 
Source” drop down box.

3. Display the Person tab and enter search text in the following 
fields that you require.

Name — Enter the search characters or string to search by the first name.
Fax Number — Enter the search characters or string to search by the contact fax 
number.
E-Mail — Enter the search characters or string to search by the contact e-mail 
address.
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NOTE: • You must enter one of the field to search contacts.  It will search the contacts that
contain the entered search strings.

SUPPLEMENT: • If you want to clear entered values, click [Clear All].

4. Click [Search].
• It begins searching contacts in the selected address book.  When it 

completes searching, found contacts appear in the list at the bottom 
of the dialog box.

• If the Address Book Viewer is launched by clicking [Select From 
Address Book] in the N/W-Fax driver, you can add the searched con-
tacts as recipients for N/W-Fax.

 P.91 "Adding contacts as recipients for N/W-Fax"

SUPPLEMENT: • If you want to stop searching, click [Stop].

Searching contacts by detailed search conditions

1. Click the [Edit] menu and select [Find].

• The Find Contact dialog box appears.

2. Select a address book to search contacts in the “Data 
Source” drop down box.
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3. Display the Detail Setting tab and select a field to search in 
the “Field Select” drop down box.

4. Select how it searches contacts in the “Condition of search 
string” drop down box.

Contains — Select this to search contacts that contain the search string.
Is — Select this to search contacts that completely match the search string.
Start with — Select this to search contacts that start with the search string.
End with — Select this to search contacts that end with the search string.

5. Enter the search string in the next field to the “Condition of 
search string” drop down box.

6. Click [Add].
• Specified search condition is added to the condition list.

SUPPLEMENT: • If you want to clear entered values, click [Clear All].

7. Repeat the procedure from Step 3 to Step 6 to add all required 
conditions.

SUPPLEMENT: • You can remove the search conditions you have added.  To do this, select the condi-
tion and click [Delete].
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8. Click [Search].
• It begins searching contacts in the selected address book.  When it 

completes searching, found contacts appear in the list at the bottom 
of the dialog box.

• If the Address Book Viewer is launched by clicking [Select From 
Address Book] in the N/W-Fax driver, you can add the searched con-
tacts as recipients for N/W-Fax.

 P.91 "Adding contacts as recipients for N/W-Fax"

SUPPLEMENT: • If you want to stop searching, click [Stop].

Adding contacts as recipients for N/W-Fax

If the Address Book Viewer is launched by clicking [Select From Address Book] in the N/
W-Fax driver, you can add the searched contacts as recipients for N/W-Fax.

1. Select the searched contacts and click [Address].

• The Type Selection dialog box appears.

2. Check the “Email Address” check box if you want to add the 
Email address of the selected contacts as the destinations, 
and chck the “Fax Number” check box if you want to add the 
fax number of the selected contacts as the destinations.

3. Click [OK].
• The Destinations dialog box appears.
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4. Click [OK].

• The selected contacts are added as recipients for N/W-Fax.

Converting the Address Book Data
Using the Address Book Converter, users can convert the GL-1010 or GL-1020 address book
file to the file that can be restored or imported to the e-STUDIO4511 Series, e-STUDIO450
Series, or e-STUDIO280 Series.
The Address Book Converter can convert the two kinds of the address book file that is created
from the GL-1010 or GL-1020 address book; one is the Address Book Converter file (*.abc) that
can be created using the backup function of the TopAccess, and the other is the CSV file that is
created using the export function of the TopAccess.

 P.93 "Converting from an address book converter file"

 P.95 "Converting from a CSV file"

NOTE: • The Address Book Converter can be launched only on Windows NT 4.0, Windows
2000, Windows XP, and Windows Server 2003.
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Converting from an address book converter file

1. Click the [Tools] menu and select [Converting].

• The Converting AddressBook dialog box appears.

2. Click [Browse] at the next of the “Input file” field.

3. Locate the folder that contains the address book converter 
file (*.abc).  Select “ABC (Address Book Converter) (*.abc)” in 
the “Files of type” drop down box, select the file, and click 
[Open].

Download from Www.Somanuals.com. All Manuals Search And Download.



94 Network Fax Guide — Managing Address Book

4. Select the model name that the selected file is originally cre-
ated from in the “Machine Type” drop down box.

5. Click [Browse] at the next of the “Output File” field.

6. Locate the folder where you want to save a converted file. 
Select “TBF (Restore) (*.tbf)” in the “Save as type” drop down 
box and click [Save].

NOTE: • When you selected an Address Book Converter file for the input file, do not specify
“CSV (Comma Separated Values) (*.csv)” in the “Save as type” drop down box.  The
Address Book Converter file cannot convert to a CSV file.
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7. Click [Convert].

• It starts converting a file.

8. Click [OK].

• The file is converted and saved in the selected folder.

SUPPLEMENT: • After you convert the file, you can restore or import the address book into the equip-
ment using the restore or import function of the TopAccess.  For instructions on how
to restore or import the address book, refer to the Network Administrator’s Guide.

Converting from a CSV file

1. Click the [Tools] menu and select [Converting].

• The Converting AddressBook dialog box appears.
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2. Click [Browse] at the next of the “Input file” field.

3. Locate the folder that contains the CSV file.  Select “CSV 
(Comma Separated Values) (*.csv)” in the “Files of type” drop 
down box, select the file, and click [Open].

4. Select the model name that the selected file is originally cre-
ated from in the “Machine Type” drop down box.

5. Click [Browse] at the next of the “Output File” field.
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6. Locate the folder where you want to save a converted file. 
Select “CSV (Comma Separated Values) (*.csv)” in the “Save 
as type” drop down box, enter the file name in the “File 
name” field, and click [Save].

NOTE: • When you selected a CSV file for the input file, do not specify “TBF (Restore) (*.tbf)”
in the “Save as type” drop down box.  The CSV file cannot convert to a Restore file.

7. Click [Convert].

• It starts converting a file.

8. Click [OK].

• The file is converted and saved in the selected folder.

SUPPLEMENT: • After you convert the file, you can restore or import the address book into the equip-
ment using the restore or import function of the TopAccess.  For instructions on how
to restore or import the address book, refer to the Network Administrator’s Guide.
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5. APPENDIX
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Cover Sheet Samples

Standard Cover Page

Reference Number: 0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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Business Cover Page

Reference Number: 0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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Professional Cover Page

Reference Number: 0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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6. INDEX
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